MM7150 Motion Module PICtail™ Plus Evaluation Board (#AC243007) with Explorer 16 Development Board User’s Guide
Note the following details of the code protection feature on Microchip devices:

- Microchip products meet the specification contained in their particular Microchip Data Sheet.
- Microchip believes that its family of products is one of the most secure families of its kind on the market today, when used in the intended manner and under normal conditions.
- There are dishonest and possibly illegal methods used to breach the code protection feature. All of these methods, to our knowledge, require using the Microchip products in a manner outside the operating specifications contained in Microchip’s Data Sheets. Most likely, the person doing so is engaged in theft of intellectual property.
- Microchip is willing to work with the customer who is concerned about the integrity of their code.
- Neither Microchip nor any other semiconductor manufacturer can guarantee the security of their code. Code protection does not mean that we are guaranteeing the product as “unbreakable.”

Code protection is constantly evolving. We at Microchip are committed to continuously improving the code protection features of our products. Attempts to break Microchip’s code protection feature may be a violation of the Digital Millennium Copyright Act. If such acts allow unauthorized access to your software or other copyrighted work, you may have a right to sue for relief under that Act.

Information contained in this publication regarding device applications and the like is provided only for your convenience and may be superseded by updates. It is your responsibility to ensure that your application meets with your specifications. MICROCHIP MAKES NO REPRESENTATIONS OR WARRANTIES OF ANY KIND WHETHER EXPRESS OR IMPLIED, WRITTEN OR ORAL, STATUTORY OR OTHERWISE, RELATED TO THE INFORMATION, INCLUDING BUT NOT LIMITED TO ITS CONDITION, QUALITY, PERFORMANCE, MERCHANTABILITY OR FITNESS FOR PURPOSE. Microchip disclaims all liability arising from this information and its use. Use of Microchip devices in life support and/or safety applications is entirely at the buyer’s risk, and the buyer agrees to defend, indemnify and hold harmless Microchip from any and all damages, claims, suits, or expenses resulting from such use. No licenses are conveyed, implicitly or otherwise, under any Microchip intellectual property rights unless otherwise stated.

Trademarks
The Microchip name and logo, the Microchip logo, AnyRate, AVR, AVR logo, AVR Freaks, BeaconThings, BitCloud, CryptoMemory, CryptoRF, dsPIC, FlashFlex, flexPWR, Heldo, JukeBlox, KEELOQ, KEELOQ logo, Kleer, LANCHECK, LINK MD, maxXStylus, maxTouch, MediaLB, megaAVR, MOST, MOST logo, MPLAB, OptoLyzer, PIC, picoPower, PICSTART, PIC32 logo, Prochip Designer, QTouch, RightTouch, SAM-BA, SpyNIC, SST, SST Logo, SuperFlash, tinyAVR, UNI/O, and XMEGA are registered trademarks of Microchip Technology Incorporated in the U.S.A. and other countries.

ClockWorks, The Embedded Control Solutions Company, EtherSynch, Hyper Speed Control, HyperLight Load, IntelliMOS, mTouch, Precision Edge, and Quiet-Wire are registered trademarks of Microchip Technology Incorporated in the U.S.A.


SQTP is a service mark of Microchip Technology Incorporated in the U.S.A.

Silicon Storage Technology is a registered trademark of Microchip Technology Inc. in other countries.

GestIC is a registered trademark of Microchip Technology Germany II GmbH & Co. KG, a subsidiary of Microchip Technology Inc., in other countries.

All other trademarks mentioned herein are property of their respective companies.

© 2014 - 2016, Microchip Technology Incorporated, All Rights Reserved.
ISBN: 9781522410980

QUALITY MANAGEMENT SYSTEM CERTIFIED BY DNV
ISO/TS 16949

Microchip received ISO/TS-16949:2009 certification for its worldwide headquarters, design and wafer fabrication facilities in Chandler and Tempe, Arizona; Gresham, Oregon and design centers in California and India. The Company's quality system processes and procedures are for its PIC® MCUs and dsPIC® DSCs, KEELOQ® code hopping devices, Serial EEPROMs, microperipherals, nonvolatile memory and analog products. In addition, Microchip’s quality system for the design and manufacture of development systems is ISO 9001:2000 certified.
Object of Declaration: MM7150 Motion Module PICtail™ Plus Evaluation Board (#AC243007) with Explorer 16 Development Board

EU Declaration of Conformity

Manufacturer: Microchip Technology Inc.
2355 W. Chandler Blvd.
Chandler, Arizona, 85224-6199
USA

This declaration of conformity is issued by the manufacturer.

The development/evaluation tool is designed to be used for research and development in a laboratory environment. This development/evaluation tool is not a Finished Appliance, nor is it intended for incorporation into Finished Appliances that are made commercially available as single functional units to end users under EU EMC Directive 2004/108/EC and as supported by the European Commission’s Guide for the EMC Directive 2004/108/EC (8th February 2010).

This development/evaluation tool complies with EU RoHS Directive 2011/65/EU.

This development/evaluation tool, when incorporating wireless and radio-telecom functionality, is in compliance with the essential requirement and other relevant provisions of the R&TTE Directive 1999/5/EC and the FCC rules as stated in the declaration of conformity provided in the module datasheet and the module product page available at www.microchip.com.

For information regarding the exclusive, limited warranties applicable to Microchip products, please see Microchip’s standard terms and conditions of sale, which are printed on our sales documentation and available at www.microchip.com.

Signed for and on behalf of Microchip Technology Inc. at Chandler, Arizona, USA

Derek Carlson
VP Development Tools

12-Sep-14
Date
Table of Contents

Preface ................................................................................................................................. 6

Chapter 1. Hardware Setup
  1.1 Hardware Requirements ........................................................................................... 10
  1.2 Preparing the Explorer 16 Development Board ....................................................... 10
  1.3 Hardware Connections for MM7150-PICtail to Explorer 16 Board ................. 10
     1.3.1 Direct Plug-In .................................................................................................. 10
     1.3.2 Using Extension Cable .................................................................................... 11

Chapter 2. Software/Firmware Setup
  2.1 Software/Firmware requirements ........................................................................... 12
  2.2 MPLABX Project: ................................................................................................... 12

Chapter 3. Demo Setup
  3.1 Running the Motion demo ....................................................................................... 15
  3.2 Calibrating Sensors ................................................................................................. 16
     3.2.1 Calibration Mode ............................................................................................ 16
     3.2.2 One-time Calibration Mode ........................................................................... 17
  3.3 Sensor Data Display ................................................................................................. 19
  3.4 Sleep/Wake ............................................................................................................. 19
  3.5 Flash Update .......................................................................................................... 20
     3.5.1 Flash Update command .................................................................................. 20
     3.5.2 Flash Configuration Update Command ......................................................... 22
     3.5.3 Flash Corruption Recovery ........................................................................... 28
  3.6 FREEFALL Mode ..................................................................................................... 29

Chapter 4. Troubleshooting
  4.1 Failure to Display Welcome Screen ......................................................................... 32
  4.2 Error Handling ......................................................................................................... 33
     4.2.1 General Error Handling for VREG Functions ............................................... 33
     4.2.2 I²C Error Handling ......................................................................................... 34
     4.2.3 Error Definitions (from source(headers/err.h)) .............................................. 35
Appendix A. Code Structure
A.1 Directory structure ................................................................. 36
A.2 Program Flow ........................................................................ 38
   A.2.1 Main.c .............................................................................. 38
   A.2.2 Configuring and Initializing MM7150 Motion Module .......... 38
   A.2.3 Enabling Sensors and Reading data .................................... 39

Appendix B. Reference Schematic & Bill of Materials
B.1 MM7150 Motion Module PICtail™ Plus Evaluation Board .......... 40
   B.1.1 Bill of Materials ................................................................. 40
   B.1.2 Reference Schematic ......................................................... 40

Appendix C. Extension Cable for Explorer 16
C.1 Signals Connection ................................................................. 42

Worldwide Sales and Service .......................................................... 43
Preface

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and documentation are constantly evolving to meet customer needs, so some actual dialogs and/or tool descriptions may differ from those in this document. Please refer to our web site (www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each page, in front of the page number. The numbering convention for the DS number is “DSXXXXXA”, where “XXXXX” is the document number and “A” is the revision level of the document.

For the most up-to-date information on development tools, see the MPLAB® IDE online help. Select the Help menu, and then Topics to open a list of available online help files.

INTRODUCTION

This chapter contains general information that will be useful to know before using the MM7150 Motion Module PICtail™ Plus Evaluation Board (#AC243007) with the Explorer 16 development board (#DM240001) to run the demo and sample code. Items discussed in this chapter include:

- Document Layout
- Audience
- Reference Documents
- Glossary
- The Microchip Web Site
- Development Systems Customer Change Notification Service
- Customer Support
- Document Revision History

DOCUMENT LAYOUT

This document describes how to use the MM7150-PICtail with Explorer 16 Development Board to perform the demo and modify sample code. The manual layout is as follows:

- Chapter 1. “Hardware Setup” – Provides hardware setting information.
- Chapter 2. “Software/Firmware Setup” – Provides software and firmware setting and build information.
- Chapter 4. “Troubleshooting” – Provides troubleshooting information.

• Appendix C. “Extension Cable for Explorer 16” – Provides signals connection information for building a custom extension cable to use with MM7150-PICtail.

AUDIENCE

This document is written for developers who are familiar with 9-axis motion sensor applications. The purpose of this document is to describe the functions and use of the MM7150-PICtail with Explorer 16 Development Board to perform the demos and modify sample code functions as described in the Host API Design for MM7150 Application Note.

REFERENCE DOCUMENTS

• DS00001885A - SSC7150 Motion Coprocessor Data Sheet
• DS00001888A - MM7150 Motion Module Data Sheet
• DS00001873A - Host API Design for MM7150 Motion Module Application Note

Note: Please contact your Microchip representative for the above documents and availability.

GLOSSARY

This section describes glossary terms and acronyms used in this document.

<table>
<thead>
<tr>
<th>TERM</th>
<th>DEFINITION</th>
</tr>
</thead>
<tbody>
<tr>
<td>EVB</td>
<td>Evaluation Board</td>
</tr>
<tr>
<td>HID</td>
<td>Human Interface Device</td>
</tr>
<tr>
<td>I²C</td>
<td>Inter-Integrated Circuit</td>
</tr>
<tr>
<td>USB</td>
<td>Universal Serial Bus</td>
</tr>
<tr>
<td>EC</td>
<td>Embedded Controller</td>
</tr>
<tr>
<td>SF</td>
<td>Sensor Fusion</td>
</tr>
</tbody>
</table>

THE MICROCHIP WEB SITE

Microchip provides online support via our web site at www.microchip.com. This web site is used as a means to make files and information easily available to customers. Accessible by using your favorite Internet browser, the web site contains the following information:

• Product Support – Data sheets and errata, application notes and sample programs, design resources, user’s guides and hardware support documents, latest software releases and archived software

• General Technical Support – Frequently Asked Questions (FAQs), technical support requests, online discussion groups, Microchip consultant program member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip press releases, listing of seminars and events, listings of Microchip sales offices, distributors and factory representatives
DEVELOPMENT SYSTEMS CUSTOMER CHANGE NOTIFICATION SERVICE

Microchip’s customer notification service helps keep customers current on Microchip products. Subscribers will receive e-mail notification whenever there are changes, updates, revisions or errata related to a specified product family or development tool of interest.

To register, access the Microchip web site at www.microchip.com, click on Customer Change Notification and follow the registration instructions.

The Development Systems product group categories are:

- **Compilers** – The latest information on Microchip C compilers, assemblers, linkers and other language tools. These include all MPLAB C compilers; all MPLAB assemblers (including MPASM assembler); all MPLAB linkers (including MPLINK object linker); and all MPLAB librarians (including MPLIB object librarian).
- **Emulators** – The latest information on Microchip in-circuit emulators. This includes the MPLAB REAL ICE and MPLAB ICE 2000 in-circuit emulators.
- **In-Circuit Debuggers** – The latest information on the Microchip in-circuit debuggers. This includes MPLAB ICD 3 in-circuit debuggers and PICkit 3 debug express.
- **MPLAB IDE** – The latest information on Microchip MPLAB IDE, the Windows Integrated Development Environment for development systems tools. This list is focused on the MPLAB IDE, MPLAB IDE Project Manager, MPLAB Editor and MPLAB SIM simulator, as well as general editing and debugging features.
- **Programmers** – The latest information on Microchip programmers. These include production programmers such as MPLAB REAL ICE in-circuit emulator, MPLAB ICD 3 in-circuit debugger and MPLAB PM3 device programmers. Also included are nonproduction development programmers such as PICSTART Plus and PIC-kit 2 and 3.

CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

- Distributor or Representative
- Local Sales Office
- Field Application Engineer (FAE)
- Technical Support

Customers should contact their distributor, representative or field application engineer (FAE) for support. Local sales offices are also available to help customers. A listing of sales offices and locations is included in the back of this document.

Technical support is available through the web site at:
http://www.microchip.com/support
## DOCUMENT REVISION HISTORY

<table>
<thead>
<tr>
<th>Revision</th>
<th>Correction</th>
</tr>
</thead>
</table>
| DS500002322E (11-18-16) | • Updated information for sample code version 1.4.0  
• Removed PIC24 Legacy PLib and replace with MCC  
• Added section 3.5.3 for Flash Corruption Recovery  
• Added Acc Range 4G/8G/16G configuration in section 3.5.2 |
| DS500002322D (08-18-15) | • Updated information for sample code version 1.3.4  
• Added section 3.6 “Free Fall Mode”  
• Updated section 4.2.3 error code |
| DS500002322C (07-02-15) | • Added section 3.2 “Calibrating Sensors”  
• Added section 3.5.2 “Flash Configuration Update” feature  
• Added Appendix C “Extension Cable” info  
• Updated all pictures with latest production MM7150-PICtail  
• Updated all figures for sample code v1.3.3 |
| DS50002322B (02-18-15) | • Added section 3.4 for Sleep/Wake feature  
• Added section 3.5 for Flash Update feature, update corresponding sections  
• Changed UART baud rate from custom 125000 to standard 19200  
• Updated all the figures to show the v1.3.2 sample code  
• Updated the correct Document Numbers in the Reference Section  
• Added section 1.1 for hardware requirements  
• Added section 2.1 for software/firmware requirements  
• Section 3.2 “Calibrating Sensors” removed |
| DS50002322A (11-07-14) | Initial Release                                                                                       |
Chapter 1. Hardware Setup

1.1 HARDWARE REQUIREMENTS

- Microchip Explorer 16 Development Board
- Microchip MM7150-PICtail Motion Module PICtail Board
- Microchip PICKit3 or ICD3 or RealICE debugger
- Null-Modem Serial Cable
- USB-to-Serial Adapter

1.2 PREPARING THE EXPLORER 16 DEVELOPMENT BOARD

- Insert PIM PIC24FJ128GA010 at Explorer 16 U1A socket
- Insert strap J7 for PIC24
- S2 switch selected for PIM
- Connect MPLAB ICD3 (or REAL ICE) In-Circuit Debugger module from HOST PC to JP1
- Connect USB-to-Serial Adapter capable of 19200 baud rate from HOST USB Port to Explorer 16 P1
  - USB-to-Serial Adapter such as Microchip MCP2200 USB to RS232 Demo Board (Microchip part#: MCP2200EV-VCP)

Note: Configure Terminal Emulation Software (ex. Tera Term) for 19200 baud, 8 bits, No Parity, 1 Stop Bit, No Flow Control.

- Power Supply (+9V) at J12

1.3 HARDWARE CONNECTIONS FOR MM7150-PICTAIL TO EXPLORER 16 BOARD

Note: Before attempting to connect the MM7150-PICtail with PICtail™ Plus Edge connector module to the Explorer 16 board, it is crucial that the power supply to the Explorer 16 be disconnected. Failure to do so may damage the MM7150 Motion Module.

1.3.1 Direct Plug-In

The MM7150-PICtail can be installed directly into the Explorer 16 Board. Insert the MM7150-PICtail into the PICtail™ header J5 with pin 1 of the module lining up with pin 1 of the header, as seen in Figure 1-1.
1.3.2 Using Extension Cable

The MM7150-PICtail motion module can be connected to the Explorer 16 development board via a custom extension cable. Using an extension cable will allow freedom of movement compared with directly inserting the MM7150-PICtail board into the PICtail header on the Explorer 16 board.

Please see Appendix C. “Extension Cable for Explorer 16” for more information.
Chapter 2. Software/Firmware Setup

2.1 SOFTWARE/FIRMWARE REQUIREMENTS

- Microchip MPLABX IDE v3.26 or later
- Microchip XC16 Compiler v1.26 or later
- Microchip MPLAB Code Configurator Plugin v3.16 or later
- MM7150_Exp16_Sample_Code_v1.4.0

Note: The latest sample code is available at www.microchip.com/motion or please contact your Microchip representative for more information.

- SSC7150 Motion Coprocessor Firmware Binary
  - The firmware can be updated using the flash update feature as described in Section 3.5.1 “Flash Update command”.
  - The firmware binary object code is encrypted and the update process is secured.

Note: The latest firmware binary file is available at www.microchip.com/motion or please contact your Microchip representative for more information.

- MM7150 Module Configuration Firmware Binary
  - The configuration data can be updated using the update feature as described in Section 3.5.2 “Flash Configuration Update Command”.

2.2 MPLABX PROJECT:

- Start MPLABX IDE as shown in Figure 2-1.

FIGURE 2-1: MPLABX IDE STARTUP SCREEN
• File->Open Project Navigate to project directory and select *Open Project* as shown in Figure 2-2.

**FIGURE 2-2: OPEN PROJECT**

![Open Project](image)

• Motion Demo Project Loaded as shown in Figure 2-3:

**FIGURE 2-3: PROJECT IS OPENED**

![Project Is Opened](image)
• With Explorer 16 power applied, make the project and download to Explorer 16 flash as shown in Figure 2-4:

FIGURE 2-4: SELECT DOWNLOAD OPTION

• Output screen during build process as shown in Figure 2-5:

FIGURE 2-5: BUILD PROCESS OUTPUT
Chapter 3. Demo Setup

3.1 RUNNING THE MOTION DEMO

Note: Using a debugger will necessitate cycling power to the connected MM7150-PICtail to reset its onboard EC (embedded controller). The easiest way to accomplish this while debugging code is to remove/install power to the Explorer 16 Development board with the MM7150-PICtail installed in J5 header. DO NOT attempt to unplug the MM7150-PICtail while power is applied to it through its connection to the Explorer 16 Development board. This can cause a power spike to the MM7150-PICtail and cause it to become inoperative.

Once the program has been built and downloaded/programmed successfully to Explorer 16 Flash, the user should observe a sequence of LED flashes on the Explorer 16 board’s LED panel.

The user should then observe the following message on the Explorer 16 board’s LCD screen:

**MM7150 Demo v140**

Select mode:

Additionally the following message will appear in the serial terminal window on the connected computer:

Note: Beginning with revision 1.3.4 of the sample code, the build number of the firmware currently loaded on the SSC7150 device is displayed (as shown).
Once this message has been displayed, the user can begin navigating the user menu using the Explorer 16 push buttons (S3/S6/S5/S4). The buttons are coded as follows:

**FIGURE 3-2: MM7150-PICTAIL ON EXP16 OVERVIEW**

![MM7150-PICTAIL ON EXP16 OVERVIEW](image)

As the UP/DOWN buttons are pressed, the Explorer 16 LCD screen will refresh and change the position of the selection cursor (“>”) to a list of available sensor types. The output to the serial monitor will also change to indicate the current sensor type which can be selected by pressing the (S5) SELECT button. Once the user selects a sensor from the menu, the sensor data output will be displayed and updated on both the LCD and serial monitor.

3.2 CALIBRATING SENSORS

3.2.1 Calibration Mode

In order for the sensors to function properly and indicate accurate data the user will need to calibrate the MM7150 each time power has been removed. This calibration is done by selecting the “Calibration” mode as shown in Figure 3-3, holding the MM7150-PICTail which is attached via an extension cable (see Appendix C. “Extension Cable for Explorer 16” for more information), or if not using an extension cable, by holding the entire Explorer 16 board with MM7150-PICTail installed, and moving it through space a few times (~ 5 seconds) to make an “infinity” symbol or a “figure 8”.

3.2.2 One-time Calibration Mode

Calibration of sensors is based on magnetic fields and magnetic flux present at the time of calibration. In the event that the MM7150-PICtail was factory calibrated in a part of the world where the magnetic flux differs significantly from its present location, the one-time calibration may be useful. One-time calibration is similar to normal calibration with one distinct difference, the final calibration will be save to NVM (Non-Volatile-Memory) upon completion.

CAUTION: Although one-time calibration appears to be a viable solution to the normal “quick” calibration each time power is removed from the MM7150-PICtail, extreme caution must be exercised in the use of the one-time calibration. The MM7150-PICtail, like all devices containing flash memory, has a limited life-cycle for updating flash memory. It is strongly recommended that the one-time calibration is only used for cases where the MM7150-PICtail’s calibration is drastically inaccurate due to magnetic field conditions that are vastly different in new locations. Even in such cases, the one-time calibration and update to NVM should be used “sparingly”.

Note: One-time calibration requires sleep/wake cycle in order to affect the changes to NVM. The HOST_TO_SH_WAKE signal MUST be provided if using an Exp16 to MM7150-PICtail extension cable.

The one-time calibration can only be completed if the NVM (Non-Volatile Memory) update flag has not been set for the current power cycle. If the NVM update flag is already set the only recourse is to Power-On Reset (POR) the Explorer16 with connected MM7150-PICtail.
One-time calibration selected from main menu:

**FIGURE 3-5: ENTER ONE-TIME CALIBRATION**

Press push-button S4 to start calibration. Similar to the “normal” calibration the MM7150-PICtail is moved through space in a figure-8 to facilitate calibration. For this mode the program will collect calibration data for at least 5 seconds and then check that the “high accuracy” flag has been set. Once this state has been achieved, the MM7150-PICtail is put to sleep and wakes in order to save the calibration settings to NVM.

**FIGURE 3-6: ONE-TIME CALIBRATION COMPLETED**
3.3 SENSOR DATA DISPLAY

Once calibrated the active sensors on the MM7150 motion module will send updates to the PIC24 on the Explorer 16 board running the application program via I²C in the form of HID packets including all relevant dimensions of data to be retrieved from the device. These sensor readings will be displayed on the LCD (as well as the COM port in a ‘linear’ formatting):

1D data: 79.0
3D data: X: 50.3 Y: 75.6 Z: -32.9
4D data: X: 1.021 Y: -.642 Z: -.458 W: .348

**Note:** Significant digits will vary based on resolution of specific sensor. This resolution can be determined by the unit exponent scaling factor. Serial data will always be displayed to 3 significant digits.

Sample output to COM port running Tera Term serial emulator:

![Display Inclinometer Data](image)

The sensor data is updated to the display every time a data register has changed since the previous update.

3.4 SLEEP/WAKE

The MM7150 motion module can be set to enter deep sleep to achieve its lowest power consumption. In the Explorer 16 sample code this can be accomplished by selecting the SLEEP command from the main menu. The Explorer 16 host will send a POWER_OFF command through the I²C interface. As a result of this SLEEP command the MM7150 motion coprocessor is halted and the I²C interface is stopped.

Select the WAKE command from the Explorer 16 main menu to wake the MM7150 motion module. This command will toggle the HOST_TO_SH_WAKE signal to alert the MM7150 to wake, send the POWER_ON command via I²C interface, and wait the required time to allow the MM7150 to fully wake and allow sensor activity to resume.
The sleep/wake process requires that certain timing constraints must be observed (shown below in Figure 3-1).

### TABLE 3-1: SLEEP / WAKE TIMING CONSTRAINTS

<table>
<thead>
<tr>
<th>Delay period</th>
<th>Reason</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Required delay between sending the SLEEP command &amp; toggling WAKE</td>
<td>70ms This is required for the coefficient write in flash during D3 plus other housekeeping activities to go into D3 state</td>
</tr>
<tr>
<td>2 Required delay between toggling (3 µs min) the wake signal and sending power ON command</td>
<td>11ms This is required for clock source switching after coming out of D3 state</td>
</tr>
<tr>
<td>3 Required delay between D3 wake and enumeration sequence start</td>
<td>30ms This is required for sensor initialization after D3 state</td>
</tr>
</tbody>
</table>

### 3.5 FLASH UPDATE

The MM7150 motion module firmware can be updated with the appropriate binary image (please refer to Section 2.1 “Software/Firmware requirements” for more information) by selecting Flash Update from the Explorer 16 main menu. The Explorer 16 sample code will reset the MM7150 module into a state able to accept the new binary image, download and CRC-check a valid binary image, program new MM7150 firmware binary via I²C interface, and finally perform image verification.

**Note:** The Explorer 16’s UART connection will be used to download the flash update binary and, as such, must be connected to a HOST PC running a terminal emulator (such as Tera Term as described in Section 1.2 “Preparing the Explorer 16 Development Board”).

#### 3.5.1 Flash Update command

Figure 3-8 shows the Flash Update Command from the Exp 16 sample code select menu.

### FIGURE 3-8: FLASH UPDATE COMMAND
Select “File->Send file…” from Tera Term utility (NOTE: Select Binary Option).

FIGURE 3-9: SELECT BINARY FILE

FIGURE 3-10: DOWNLOADING BINARY IMAGE
Selection of the Flash Update mode will require cycling power to the Explorer 16 (and attached MM7150-PICtail) regardless if the flash update procedure is successful, aborted, or an error is encountered. Initial setup for this flash update sequence requires the MM7150 to enter "BootLoader" mode from which normal operation is not possible, therefore a POR to the MM7150-PICtail is required.

### 3.5.2 Flash Configuration Update Command

The X/Y/Z orientation of the MM7150 module on the customer’s design can be modified and saved to the MM7150’s flash. The default orientation of the A/M/G sensors of MM7150 (placed horizontally) is:
For this case, the inputs to the motion algorithm (running in MM7150 firmware) can be represented by the following 3x3 matrix (Accelerometer for example):

\[
\text{Matrix}_{3,3} = \begin{bmatrix}
A_{00}, & A_{01}, & A_{02}; \\
A_{10}, & A_{11}, & A_{12}; \\
A_{20}, & A_{21}, & A_{22};
\end{bmatrix};
\]

where \(A_{xx}\) could be 0, 1, or -1.

So, for the horizontal orientation shown above and assuming that \(X/Y/Z\) are data read from the hardware sensor and \(X'/Y'/Z'\) are data input to the motion algorithm:

\[
X' = A_{00}x + A_{01}y + A_{02}z \\
y' = A_{10}x + A_{11}y + A_{12}z \\
z' = A_{20}x + A_{21}y + A_{22}z
\]

Since the input matrix corresponds one to one in \(X/Y/Z\) to the output matrix, we obtain the following:

\[
X' = 1x + 0y + 0z \\
y' = 0x + 1y + 0z \\
z' = 0x + 0y + 1z
\]

i.e. Resulting matrix\(3, 3\) = \[1,0,0; 0,1,0; 0,0,1;\]

This orientation configuration data must be sent to the appropriate sector in the MM7150 firmware in the following format:

**TABLE 3-2: CONFIGURATION DATA FORMAT FOR HORIZONTAL**

<table>
<thead>
<tr>
<th>Name</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Header</td>
<td>A5A5A5A5</td>
</tr>
<tr>
<td>Serial_num</td>
<td>00000000</td>
</tr>
<tr>
<td>ACC_matrix</td>
<td>0100000000100000001</td>
</tr>
<tr>
<td>MAG_matrix</td>
<td>010000001000000001</td>
</tr>
<tr>
<td>GYR_matrix</td>
<td>010000000100000001</td>
</tr>
<tr>
<td>Reserved</td>
<td>00</td>
</tr>
<tr>
<td>ACC_config</td>
<td>01010110</td>
</tr>
<tr>
<td>MAG_config</td>
<td>02010112</td>
</tr>
<tr>
<td>GYR_config</td>
<td>03010168</td>
</tr>
<tr>
<td>Reserved</td>
<td>04010144</td>
</tr>
<tr>
<td>Reserved</td>
<td>05010177</td>
</tr>
<tr>
<td>Reserved</td>
<td>06000000</td>
</tr>
<tr>
<td>Reserved</td>
<td>07000000</td>
</tr>
<tr>
<td>Reserved</td>
<td>08000000</td>
</tr>
<tr>
<td>Reserved</td>
<td>09000000</td>
</tr>
<tr>
<td>ACC_range</td>
<td>00030000 (see Note 1)</td>
</tr>
<tr>
<td>Chk_sum</td>
<td>1C040000 (see Note 2)</td>
</tr>
<tr>
<td>Padded</td>
<td>FF’s for 128 byte packet</td>
</tr>
</tbody>
</table>
**Note 1:** SSC7150 Firmware Build 0A00 supports the accelerometer range option as shown below:

- \( \text{ACC\_range} = 00030000: +/\ - 2G \)
- \( \text{ACC\_range} = 00050000: +/\ - 4G \)
- \( \text{ACC\_range} = 00080000: +/\ - 8G \)
- \( \text{ACC\_range} = 000C0000: +/\ - 16G \)

2: Check sum will be calculated by the sample code flash configuration update command, as a result this field will be ignored and can be: 00000000.

For example, the XYZ matrix result for the accelerometer (acc\_matrix) takes the form of:

\( \text{ACC\_matrix} = 01 \ 00 \ 00 \ (X=1,0,0) \ 00 \ 01 \ 00 \ (Y=0,1,0) \ 00 \ 00 \ 01 \ (Z=0,0,1) \)

For MM7150_Exp16_Sample_Code_v1.4.0, the flash configuration data needs to be in the following *binary* file format (derived from the above text file):

**FIGURE 3-12: CONFIGURATION DATA BINARY FOR HORIZONTAL**

<table>
<thead>
<tr>
<th>00000000</th>
<th>A5</th>
<th>A5</th>
<th>A5</th>
<th>A5</th>
<th>00</th>
<th>00</th>
<th>00</th>
<th>01</th>
<th>00</th>
<th>00</th>
<th>01</th>
<th>00</th>
<th>00</th>
<th>00</th>
<th>00</th>
</tr>
</thead>
<tbody>
<tr>
<td>00000010</td>
<td>01</td>
<td>01</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>01</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>01</td>
<td>01</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>01</td>
</tr>
<tr>
<td>00000020</td>
<td>00</td>
<td>00</td>
<td>01</td>
<td>00</td>
<td>01</td>
<td>01</td>
<td>01</td>
<td>01</td>
<td>10</td>
<td>02</td>
<td>01</td>
<td>01</td>
<td>12</td>
<td>03</td>
<td>01</td>
</tr>
<tr>
<td>00000030</td>
<td>04</td>
<td>01</td>
<td>01</td>
<td>44</td>
<td>05</td>
<td>01</td>
<td>01</td>
<td>77</td>
<td>06</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>07</td>
<td>00</td>
<td>00</td>
</tr>
<tr>
<td>00000040</td>
<td>08</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>09</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>03</td>
<td>00</td>
<td>00</td>
<td>01</td>
<td>04</td>
</tr>
<tr>
<td>00000050</td>
<td>FF</td>
<td>FF</td>
<td>FF</td>
<td>FF</td>
<td>FF</td>
<td>FF</td>
<td>FF</td>
<td>FF</td>
<td>FF</td>
<td>FF</td>
<td>FF</td>
<td>FF</td>
<td>FF</td>
<td>FF</td>
<td>FF</td>
</tr>
<tr>
<td>00000060</td>
<td>FF</td>
<td>FF</td>
<td>FF</td>
<td>FF</td>
<td>FF</td>
<td>FF</td>
<td>FF</td>
<td>FF</td>
<td>FF</td>
<td>FF</td>
<td>FF</td>
<td>FF</td>
<td>FF</td>
<td>FF</td>
<td>FF</td>
</tr>
<tr>
<td>00000070</td>
<td>FF</td>
<td>FF</td>
<td>FF</td>
<td>FF</td>
<td>FF</td>
<td>FF</td>
<td>FF</td>
<td>FF</td>
<td>FF</td>
<td>FF</td>
<td>FF</td>
<td>FF</td>
<td>FF</td>
<td>FF</td>
<td>FF</td>
</tr>
</tbody>
</table>

Similarly, for the A/M/G sensors of the MM7150 placed vertically (such as when plugged into the Explorer 16 card):

![Diagram](image)
For the vertical orientation shown above and assuming that X/Y/Z are data read from the hardware sensor and X'/Y'/Z' are data input to the motion algorithm with respect to the default X/Y/Z settings:

\[
X' = A00*x + A01*y + A02*z \\
Y' = A10*x + A11*y + A12*z \\
Z' = A20*x + A21*y + A22*z
\]

Since, for this case, the input matrix does not correspond one to one in X/Y/Z to the output matrix, we obtain the following translations:

\[
X' = 1*x + 0*y + 0*z \\
Y' = 0*x + 0*y - 1*z \\
Z' = 0*x + 1*y + 0*z
\]

i.e. Resulting matrix[3, 3] = [1,0,0; 0,0,-1; 0,1,0;]

This vertical configuration data can be sent to the appropriate sector in the MM7150 firmware in the following format:

**TABLE 3-3: CONFIGURATION DATA FORMAT FOR VERTICAL**

<table>
<thead>
<tr>
<th>Name</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Header</td>
<td>A5A5A5A5A5</td>
</tr>
<tr>
<td>Serial_num</td>
<td>00000000</td>
</tr>
<tr>
<td>ACC_matrix</td>
<td>010000000000FF000100</td>
</tr>
<tr>
<td>MAG_matrix</td>
<td>010000000000FF000100</td>
</tr>
<tr>
<td>GYR_matrix</td>
<td>010000000000FF000100</td>
</tr>
<tr>
<td>Reserved</td>
<td>00</td>
</tr>
<tr>
<td>ACC_config</td>
<td>01010110</td>
</tr>
<tr>
<td>MAG_config</td>
<td>02010112</td>
</tr>
<tr>
<td>GYR_config</td>
<td>03010168</td>
</tr>
<tr>
<td>Reserved</td>
<td>04010144</td>
</tr>
<tr>
<td>Reserved</td>
<td>05010177</td>
</tr>
<tr>
<td>Reserved</td>
<td>06000000</td>
</tr>
<tr>
<td>Reserved</td>
<td>07000000</td>
</tr>
<tr>
<td>Reserved</td>
<td>08000000</td>
</tr>
<tr>
<td>Reserved</td>
<td>09000000</td>
</tr>
<tr>
<td>ACC_range</td>
<td>00030000 (see Note 1)</td>
</tr>
<tr>
<td>Chk_sum</td>
<td>16070000 (see Note 2)</td>
</tr>
<tr>
<td>Padded</td>
<td>FF's for 128 byte package</td>
</tr>
</tbody>
</table>

For MM7150_Exp16_Sample_Code_v1.4.0, the flash configuration data must adhere to the following *binary* file format:
Using the sample code's Flash Configuration Update mode:

Select “File->Send file...” from TeraTerm utility: (NOTE: Select Binary Option).
Select "Open" to download binary file to flash.

Following successful completion of the flash configuration update procedure (or if any error is encountered), the Explorer 16 must be power cycled (POR).

**Note:** Should an issue arise due to incorrect formatting of binary data, the MM7150 Flash can be restored using the Flash Update command in Section 3.5.1 “Flash Update command”.
3.5.3 Flash Corruption Recovery

If flash update was not completed in an orderly manner, the flash ROM in SSC7150 may be corrupted. For example, when the power is down while the flash update is in progress. In such case, the SSC7150 will power up into a boot loader mode when the flash ROM is corrupted. The sample code has a capability to detect the boot loader mode and re-flash the firmware binary to recovery the device.

At boot, if the boot loader mode is detected, then the flash update function runs automatically. The user can select and download the firmware binary file as described in Section 3.5.1 “Flash Update command” to recover from the flash corruption state.
3.6 FREEFALL MODE

Free-fall detection by the MM7150 at the present time is not supported in the MM7150 firmware. Included in the Explorer16 with MM7150 sample code version 1.3.4 is a software solution to demonstrate free-fall detection of the MM7150.

Free-fall is the acceleration of a device due to the effects of gravity. The simplest type of free-fall is “linear” free-fall wherein the orientation of the device remains constant along its three axes as it moves or falls. Output from the accelerometer is based on the effects (or acceleration) of gravity. The accelerometer is used to detect when a device is free-falling. Starting from a stationary or static orientation, a device will have X=0g, Y=0g, and Z=-1g accelerometer readings. The X and Y 0g readings occur because these vectors are perpendicular to gravity and thus gravity has no effect on them. However, for the Z = -1g reading, the 1g is due to the Z axis or vector being parallel to the gravity component acting on the device in the downward direction and “-” refers to the direction opposite the effect of gravity.

For example, a MM7150-PICtail with a horizontal configuration (stored in flash, see Section 3.5.2 “Flash Configuration Update Command”) is held in a static horizontal position then the X, Y, and Z components (of acceleration) are found to be: X=0, Y=0, Z=-1. (Refer to Figure 3-18 below, X = 0g because this vector is perpendicular to gravity, so also for Y = 0g. Z = -1g because its axis is parallel and opposite the direction of gravity.) When the MM7150-PICtail device is dropped, and considering linear free-fall only, all three axes will converge to ideally 0g.
For the sample code demonstration, the accelerometer is configured for maximum sensitivity (= 0) and data rate (=10 ms). In order to achieve a data rate = 10 ms per sample, the output to the UART and LCD screens, which cause a viable delay during output display, are disabled temporarily while the accelerometer data is collected. An extension cable must be used (see Appendix C. “Extension Cable for Explorer 16”) for the Explorer 16 to MM7150-PICtail in order to drop the device onto a soft landing surface.

It is virtually impossible to preserve the orientation of the MM7150-PICtail (i.e. prevent it from tilting, rotating, or spinning) during the fall without a specialized test setup so the sample code factors-in an offset for the X, Y, and Z readings during the collection of the accelerometer data. When the X, Y, and Z readings are within the expected range, all approaching zero, and continue for successive readings, free-fall is determined to be occurring. Free-fall can be detected at heights above ~1” from the soft landing pad. Impact with the landing pad will also be determined by observing accelerometer readings in excess of 1g.
The data logging begins when the first X,Y,Z readings are below the expected threshold and all approaching zero. The “free-falling” determination is made if two successive readings are within the predetermined range. Any discrepancies in the data logging are due to changes in orientation of the MM7150-PICtail device as it falls. Finally, as seen in Figure 3-20, “impact” with the “ground” or landing pad is also determined.
Chapter 4. Troubleshooting

This chapter describes troubleshooting potential issues and fixes.

4.1 FAILURE TO DISPLAY WELCOME SCREEN

If the welcome message fails to display on the Explorer 16 LCD screen and error messages depicted below appear in the debugger’s output (using Microchip ICD3 or REAL ICE debugger for instance), the most likely cause is a failure to disconnect and reconnect power to the MM7150-PICtail. This is accomplished by disconnecting and reconnecting power to the Explorer 16 board before restarting the demo. This process serves as a ‘hard reset’ for the SSC7150 on the MM7150-PICtail, allowing I²C communication to reinitialize and restart.

FIGURE 4-1: ERROR MESSAGE IN DEBUGGER’S TAB

![Error Message in Debugger’s Tab](image1)

Note: If user is running on a different debugger (eg: ICD3, Real ICE etc.) the message would appear in that debugger’s output tab.

FIGURE 4-2: ERROR MESSAGE IN DEBUGGER CONSOLE TAB.

![Error Message in Debugger Console Tab](image2)
4.2 ERROR HANDLING

4.2.1 General Error Handling for VREG Functions

**Note:** Please refer to “DS00001873A - Host API Design for MM7150-PICtail Motion Module Application Note” for more information regarding virtual registers (VREG) defined and used in the sample code.

VREG functions which fail to complete due to certain hardware events may display error information via error handling output on the Explorer 16 board’s LCD screen and on the serial terminal window on the connected computer.

For example, in the case of a VREG Read operation of register 16h which encounters a problem while reading data in response to receiving a **HIDI2C_HOST_INT** (which indicates that a MM7150 sensor has data available) the following will be displayed on the Explorer 16 board’s LCD:

```
VRRd:16 err=0x31
Push S5 to cont
```

where:

- **VRRd:16** - Attempting a VREG Read operation on register 16h (VREG ACXD register)
- **err=0x31** – Error code generated (see error code definitions in Section 4.2.3)
- **Push S5 to cont** - Press button S5 to attempt to recover from the reported error

The same error is displayed on the serial terminal window on the connected computer:

**FIGURE 4-3: SERIAL TERMINAL GENERAL ERROR HANDLING DISPLAY**

<table>
<thead>
<tr>
<th>Function</th>
<th>Error Handler Output Abbreviation</th>
</tr>
</thead>
<tbody>
<tr>
<td>VREG_init( )</td>
<td>Vini</td>
</tr>
<tr>
<td>HOST_SF_LIB_VREG_read()</td>
<td>VRRd</td>
</tr>
<tr>
<td>HOST_SF_LIB_VREG_write()</td>
<td>VRWr</td>
</tr>
<tr>
<td>I2cIO()</td>
<td>i2c</td>
</tr>
</tbody>
</table>
4.2.2 I2C Error Handling

Upper level functions which employ I2C function calls for the Explorer 16 board’s PIC24 to MM7150 interface that fail to complete will display error information. The I2C error handling display is output on the Explorer 16 board’s LCD screen and on the serial terminal window on the connected computer.

Note: Most, if not all, I2C errors are hardware dependent. As this sample code is specific to the PIC24 on the Explorer 16 board, I2C errors are simply flagged as an error to illustrate where the issue was encountered. For this demo, in the rare event that a fully functional I2C interface encounters an error, the error “recovery” method will require resetting the Explorer 16 board and, hence, the connected MM7150-PICtail.

For example, in the case of an i2cIO operation which encounters an issue, wherein the MM7150 fails to ACK properly, the following will be displayed on the Explorer 16 board’s LCD:

```
i2c  error=0x29
POR Exp16 Board
```

where:

- `i2c` - error occurred in i2cIO() function
- `error=0x29` – error code generated (see error code definitions in Section 4.2.3)

**POR Exp16 Board** - Power On Reset Explorer 16 board (and connected MM7150-PICtail)

The same error is displayed on the serial terminal window on the connected computer:

**FIGURE 4-4: SERIAL TERMINAL I2C ERROR HANDLING DISPLAY**
### 4.2.3 Error Definitions (from source/headers/err.h)

<table>
<thead>
<tr>
<th>Error Value</th>
<th>Definition</th>
<th>Module/Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>SUCCESS</td>
<td></td>
</tr>
<tr>
<td>10h</td>
<td>ID_FAIL</td>
<td>sf.c</td>
</tr>
<tr>
<td>11h</td>
<td>HID_DESC_FAIL</td>
<td>sf.c</td>
</tr>
<tr>
<td>12h</td>
<td>RPT_DESC_FAIL</td>
<td>sf.c</td>
</tr>
<tr>
<td>14h</td>
<td>REP_PARS_FAIL</td>
<td>sf.c</td>
</tr>
<tr>
<td>15h</td>
<td>NO_EOC_FAIL</td>
<td>sf.c</td>
</tr>
<tr>
<td>16h</td>
<td>RESET_FAIL</td>
<td>sf.c</td>
</tr>
<tr>
<td>17h</td>
<td>POWER_ON_FAIL</td>
<td>sf.c</td>
</tr>
<tr>
<td>18h</td>
<td>GET_FEAT_FAIL</td>
<td>sf.c</td>
</tr>
<tr>
<td>19h</td>
<td>SET_FEAT_FAIL</td>
<td>sf.c</td>
</tr>
<tr>
<td>1Ah</td>
<td>SET_RPT_FAIL</td>
<td>sf.c</td>
</tr>
<tr>
<td>1Bh</td>
<td>SLEEP_CMD_FAIL</td>
<td>sf.c</td>
</tr>
<tr>
<td>1Ch</td>
<td>HID_GET_RPT_INPT_FAIL</td>
<td>sf.c</td>
</tr>
<tr>
<td>1Dh</td>
<td>HID_GET_RPT_FEAT_FAIL</td>
<td>sf.c</td>
</tr>
<tr>
<td>1Eh</td>
<td>WAKE_CMD_FAIL</td>
<td>sf.c</td>
</tr>
<tr>
<td>21h</td>
<td>I2C_ERROR</td>
<td>i2clO.c</td>
</tr>
<tr>
<td>22h</td>
<td>I2C_BUF_OVERFLO</td>
<td>i2clO.c</td>
</tr>
<tr>
<td>23h</td>
<td>WRITE_COLL</td>
<td>i2clO.c</td>
</tr>
<tr>
<td>24h</td>
<td>NOT_ACK</td>
<td>i2clO.c</td>
</tr>
<tr>
<td>25h</td>
<td>BUS_COLL</td>
<td>i2clO.c</td>
</tr>
<tr>
<td>26h</td>
<td>RX_OVRFLLO</td>
<td>i2clO.c</td>
</tr>
<tr>
<td>27h</td>
<td>HID_DESC_RET</td>
<td>i2clO.c</td>
</tr>
<tr>
<td>28h</td>
<td>REP_DESC_RET</td>
<td>i2clO.c</td>
</tr>
<tr>
<td>29h</td>
<td>I2C_TIMEOUT_ERR</td>
<td>i2clO.c</td>
</tr>
<tr>
<td>31h</td>
<td>HID_INT_FAIL</td>
<td>vregs.c</td>
</tr>
<tr>
<td>32h</td>
<td>VREG_ACCESS_ERR</td>
<td>vregs.c</td>
</tr>
<tr>
<td>33h</td>
<td>VREG_OFFSET_ERR</td>
<td>vregs.c</td>
</tr>
<tr>
<td>41h</td>
<td>FLUSH_INFO_ERR</td>
<td>flash_update.c</td>
</tr>
<tr>
<td>42h</td>
<td>FLUSH_WRITE_ERR</td>
<td>flash_update.c</td>
</tr>
<tr>
<td>43h</td>
<td>FLUSH_VERIFY_ERR</td>
<td>flash_update.c</td>
</tr>
<tr>
<td>44h</td>
<td>FLUSH_CRC_ERR</td>
<td>flash_update.c</td>
</tr>
</tbody>
</table>
Appendix A. Code Structure

A.1 DIRECTORY STRUCTURE
TABLE A-1: DIRECTORY STRUCTURE OF THE SENSOR FUSION SAMPLE CODE

<table>
<thead>
<tr>
<th>Files</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>\source\headers\app.h</td>
<td>Include for all other underlying h files and typedefs</td>
</tr>
<tr>
<td>\source\headers\err.h</td>
<td>Functions and parameters for error handling</td>
</tr>
<tr>
<td>\source\headers\flash_update.h</td>
<td>Functions for flash update</td>
</tr>
<tr>
<td>\source\headers\i2cIO.h</td>
<td>Functions and parameters specific to I²C communication with MM7150 module</td>
</tr>
<tr>
<td>\source\headers\lcd.h</td>
<td>Functions relevant to LCD operation</td>
</tr>
<tr>
<td>\source\headers\sf.h</td>
<td>Functions relevant to decoding and encoding HID commands and packets</td>
</tr>
<tr>
<td>\source\headers\system.h</td>
<td>Functions relevant to running the demo</td>
</tr>
<tr>
<td>\source\headers\vregs.h</td>
<td>Functions relevant to the creation of the virtual register layer of the MM7150 API library</td>
</tr>
<tr>
<td>\source\src\err.c</td>
<td>Error handling functions for I²C and VREG operations</td>
</tr>
<tr>
<td>\source\src\flash_update.c</td>
<td>Functions for flash update.</td>
</tr>
<tr>
<td>\source\src\i2cIO.c</td>
<td>Functions to communicate with MM7150 Module via I²C</td>
</tr>
<tr>
<td>\source\src\lcd.c</td>
<td>LCD support for Explorer 16 board</td>
</tr>
<tr>
<td>\source\src\mmain.c</td>
<td>Functions to setup Explorer 16 board environment, COM port UART2, interrupts, timers, I²C, HID_initialization, start HID handshaking with EC via I²C commands</td>
</tr>
<tr>
<td>\source\src\sf.c</td>
<td>Functions to get HID tables from MM7150 Module, send power and reset HID commands, get HID report descriptors, parse descriptors, get input from sensor devices</td>
</tr>
<tr>
<td>\source\src\system.c</td>
<td>Initiates the motion demo by configuring LED’s, LCD, Serial, and buttons</td>
</tr>
<tr>
<td>\source\src\utils.c</td>
<td>Assorted functions</td>
</tr>
<tr>
<td>\source\src\vregs.c</td>
<td>Mediator between HID-I²C communication and user Commands (interactive layer of API)</td>
</tr>
<tr>
<td>mcc_generated_files\ext_int.h</td>
<td>Functions for external interrupt</td>
</tr>
<tr>
<td>mcc_generated_files\i2c1.h</td>
<td>Functions and data definitions for I2C1 driver</td>
</tr>
<tr>
<td>mcc_generated_files\interrupt_manager.h</td>
<td>Functions for interrupt initialization</td>
</tr>
<tr>
<td>mcc_generated_files\mcc.h</td>
<td>Include for all other MCC generated header files</td>
</tr>
<tr>
<td>mcc_generated_files\pin_manager.h</td>
<td>Macro functions for GPIOs</td>
</tr>
<tr>
<td>mcc_generated_files\tmr1.h</td>
<td>Functions for Timer 1</td>
</tr>
<tr>
<td>mcc_generated_files\tmr2.h</td>
<td>Functions for Timer 2</td>
</tr>
<tr>
<td>mcc_generated_files\traps.h</td>
<td>Functions for traps</td>
</tr>
<tr>
<td>mcc_generated_files\uart2.h</td>
<td>Functions for UART 2</td>
</tr>
<tr>
<td>mcc_generated_files\ext_int.c</td>
<td>External interrupt handler</td>
</tr>
<tr>
<td>mcc_generated_files\i2c1.c</td>
<td>I2C1 driver functions and interrupt handler</td>
</tr>
<tr>
<td>mcc_generated_files\interrupt_manager.c</td>
<td>Interrupt initialization and management</td>
</tr>
<tr>
<td>mcc_generated_files\mcc.c</td>
<td>System initialization</td>
</tr>
<tr>
<td>mcc_generated_files\pin_manager.c</td>
<td>GPIO configuration</td>
</tr>
<tr>
<td>mcc_generated_files\tmr1.c</td>
<td>Timer 1 driver functions and interrupt handler</td>
</tr>
<tr>
<td>mcc_generated_files\tmr2.c</td>
<td>Timer 2 driver functions and interrupt handler</td>
</tr>
</tbody>
</table>
### A.2 PROGRAM FLOW

#### A.2.1 Main.c

**FIGURE A-1: PROGRAM FLOW CHART**

- **sys_init():** Initialize interrupts, LED’s, LCD screen, buttons, and serial communication (19200 baud)
- **VREG_init():** Initialize VREGS; Retrieve HID & report descriptors, and all device features
- **display_menu():** Display menu to user and begin handling button presses until a selection is made
- **Enable user’s selected sensor; set its sensitivity and data reporting rate; retrieve the unit exponent factor for the data**
- **Retrieve and display sensor data until the user presses reset button to exit, and disable user’s selected sensor**

### A.2.2 Configuring and Initializing MM7150 Motion Module

**Note:** For a more comprehensive explanation of the API library functions, see the Host API Design for MM7150 Application Note.

**VREG_init (VREGS.c) – procedure for preparing motion module for data reporting**

1. hid_i2c_descriptor_handler(GET_HID_DESC)
   - Retrieve and parse the HID descriptor table
2. hid_i2c_cmd_process (POWER_ON)
   - Wake the EC
3. hid_i2c_cmd_process (RESET)
   - Reset the EC
4. hid_i2c_descriptor_handler(GET_REPT_DESC)
   - Retrieve and parse report descriptor table
5. hid_i2c_cmd_process (HID_GET_RPT_FEAT, rept_ID)
   - Get feature reports for sensors
A.2.3 Enabling Sensors and Reading data

1. HOST_SF_LIB_write(0, 0bXXXXXXXXXX0101)
   - Enable one or multiple sensors
2. HOST_SF_LIB_write regX, sensitivity value
   - Optional - edit sensitivity per sensor
3. HOST_SF_LIB_write regX, data rate value
   - Optional - edit data rate per sensor
4. HOST_SF_LIB_write(DATA_REG)
   - Read input data from the enabled sensors
Appendix B. Reference Schematic & Bill of Materials

B.1 MM7150 MOTION MODULE PICTAIL™ PLUS EVALUATION BOARD

B.1.1 Bill of Materials

<table>
<thead>
<tr>
<th>Designator</th>
<th>Quantity</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>J1</td>
<td>1</td>
<td>CON HDR-2.54 Male 1x4 Gold 5.84MH TH VERT</td>
<td>HDR-2.54 Male 1x4</td>
</tr>
<tr>
<td>J2</td>
<td>1</td>
<td>CON HDR-2.54 Male 1x6 Tin 5.84MH TH VERT</td>
<td>HDR-2.54 Male 1x6</td>
</tr>
<tr>
<td>J3</td>
<td>1</td>
<td>CON HDR-2.54 Female 1x6 Gold TH R/A</td>
<td>HDR-2.54 Female 1x6</td>
</tr>
<tr>
<td>JP1, JP2, JP3</td>
<td>3</td>
<td>CON HDR-2.54 Male 1x2</td>
<td>HDR-2.54 Male 1x2</td>
</tr>
<tr>
<td>LED1, LED2</td>
<td>2</td>
<td>DIO LED YELLOW 2.1V 30mA 6mcd Clear SMD 0805</td>
<td>YELLOW</td>
</tr>
<tr>
<td>LED3</td>
<td>1</td>
<td>LED 3MM RT ANG HI EFF GRN PC MNT - Dialight 551-0209F</td>
<td>GREEN</td>
</tr>
<tr>
<td>R1, R2, R4</td>
<td>3</td>
<td>RES TKF 301R 1% 1/10W SMD 0603</td>
<td>301R</td>
</tr>
<tr>
<td>R3, R5</td>
<td>2</td>
<td>RES TKF 10k 1% 1/16W SMD 0603, RES TKF 0R 1/10W SMD 0603</td>
<td>10k, DNP</td>
</tr>
<tr>
<td>R6</td>
<td>1</td>
<td>RES TKF 0R 1/10W SMD 0603</td>
<td>0R</td>
</tr>
<tr>
<td>R7, R8</td>
<td>2</td>
<td>RES TKF 2.21k 1% 1/10W SMD 0603</td>
<td>2.21k</td>
</tr>
<tr>
<td>R9</td>
<td>1</td>
<td>RES TKF 2.21k 1% 1/10W SMD 0603</td>
<td>DNP</td>
</tr>
<tr>
<td>U1</td>
<td>1</td>
<td>MM7150 Motion Module</td>
<td></td>
</tr>
</tbody>
</table>

B.1.2 Reference Schematic

The MM7150 Motion Module PICtail™ Plus Evaluation Board (#AC243007) reference schematic is shown in the next page.
Please refer to MM7150-PICTail Reference Schematic (B.1.2 “Reference Schematic”) and create an extension cable of up to 20” (with proper shielding) for ease of motion during calibration.

Note: Per industry data, I²C bus at 400KHz without buffer can have length up to 2 meters with limiting factor of wiring capacitance. Designers should take this into consideration if planning to build longer extension cable which is out of scope of this user’s guide.

### Table C-1: Connection Summary Between MM7150 to EXP16 Board

<table>
<thead>
<tr>
<th>Signal Name</th>
<th>SSC7150 Module Pin</th>
<th>SSC7150 J3 Header</th>
<th>MM7150 Module Z1 PICTail Connector</th>
<th>Exp16 J6 Header Name</th>
<th>Exp16 J6 Header Pin</th>
</tr>
</thead>
<tbody>
<tr>
<td>+3.3V</td>
<td>7</td>
<td>1</td>
<td>21</td>
<td>+3.3V</td>
<td>21</td>
</tr>
<tr>
<td>GND</td>
<td>8</td>
<td>2</td>
<td>15</td>
<td>GND</td>
<td>9</td>
</tr>
<tr>
<td>HIDI2C_HOST_INT</td>
<td>4</td>
<td>3</td>
<td>18</td>
<td>RE8/INT1</td>
<td>18</td>
</tr>
<tr>
<td>HIDI2C_HOST_DAT</td>
<td>16</td>
<td>5</td>
<td>8</td>
<td>RG3/SDA1</td>
<td>8</td>
</tr>
<tr>
<td>HIDI2C_HOST_CLK</td>
<td>15</td>
<td>6</td>
<td>6</td>
<td>RG2/SCL1</td>
<td>6</td>
</tr>
<tr>
<td>HOST_TO_SH_WAKE</td>
<td>1</td>
<td>NC</td>
<td>17</td>
<td>RE9</td>
<td>17</td>
</tr>
</tbody>
</table>